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2  Biopac Student Lab 

Welcome to the Biopac Student Lab! 
This Tutorial covers basic concepts that make the Biopac Student Lab (BSL) System unique and powerful and 
provides detailed instructions on how to use important features of the program for data recording and analysis. 

You are encouraged to open the Sample Data File and follow along as you complete the Tutorial. Have fun 

experimenting with the display and analysis functions of Biopac Student Lab—interacting with the software as the 
Tutorial explains functionality will ease the learning curve. For more information, see your instructor or review the 

Software Guide. 

Biopac Student Lab System 

The Biopac Student Lab System is an integrated set of software and hardware for life science data acquisition 

and analysis. 

 

Software Biopac Student Lab software includes guided Lessons and BSL PRO options for advanced analysis. 

The software will guide you through each Lesson with buttons and text and will also help you manage 

data saving and data review.  

Hardware Includes the MP Data Acquisition Unit (MP36, MP35, or MP45,) electrodes, electrode lead cables, 

transducers, headphones, connection cables, wall transformer, and other accessories.  

HOW THE BIOPAC STUDENT LAB WORKS 

One way to think about how Biopac Student Lab works is to liken it to a video camera connected to a computer 

and displayed through the computer monitor. The images the camera captures are stored on the computer to be 

archived or viewed later. 

Like a video camera, Biopac Student Lab records information about the outside world, although the types of 
information it collects are different. Whereas cameras record visual information, Biopac Student Lab records 

information (“signals”) about your physiological state, whether in the form of skin temperature, the signal from a 

beating heart, or the flexing of an arm muscle. 

Biopac Student Lab Software 

Biopac Student Lab Hardware 

Electrode leads and 
Transducers 

MP45 (2-channel system) 

The input ports on the front of the MP unit are referred to as Channels and are labeled CH 1, CH 2, CH 3, 
and CH 4. The Analog Out port on back of the MP3X units allows signals to be amplified and sent out to 

devices such as headphones; on the MP36, Analog Out is a built-in low voltage stimulator. 

MP3X (4-channel system) 
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This physiological information is transferred via a cable from the Subject to the Biopac Student Lab application. 

The type of physiological signals being measured will determine the type of device on the end of the cable. 

When the signal reaches Biopac Student Lab, it is converted into a digital format, after which the signal is 

displayed on the monitor as a physiological waveform. 

It takes about 1/1,000 of a second from the time a signal is picked-up by a sensor until it appears on the computer 

monitor. The computer’s internal memory can save these signals much like the camera can save digital video 

images. Like a video recording, you can use Biopac Student Lab to recall previously collected data. And like a 

video, you can edit and manipulate the information stored in a Biopac Student Lab graph data file. 

Biopac Student Lab software acquires the signal from the MP unit and plots it as a waveform in the graph file. The 
waveform may be a direct reflection of the electrical signal from the MP channel or a different waveform based on 

the signal coming into the MP unit. 

• For example, the electrical signal into the MP unit may be an ECG signal, but the software may convert this to 

display a Beats Per Minute (BPM) waveform. 

The Body Electric 

When most people think of electricity flowing through bodies, unique animals such as electric eels come to mind, 
or rare events such as being struck by lightning. Nevertheless, electricity is part of everything our bodies do...from 

thinking to exercising—even sleeping. 

Physiology and electricity share a common history, with some of the 

pioneering work in each field being done in the late 1700’s by Count 

Alessandro Giuseppe Antonio Anastasio Volta and Luigi Galvani. Count 

Volta, among other things, invented the battery and had a unit of electrical 
measurement named in his honor (the Volt). These early researchers studied 

“animal electricity” and were among the first to realize that applying an 

electrical signal to an isolated animal muscle caused it to twitch. Even today, 

many classrooms use procedures similar to Count Volta’s to demonstrate 

how muscles can be electrically stimulated.  

Through your lab work, you will likely see how your body generates 

electricity while doing specific things like flexing a muscle or how a beating 

heart produces a recognizable electric “signature.” Many of the lessons 

covered in this manual measure electrical signals originating in the body. To 
fully understand how electrical signals work requires a basic knowledge of 

the physics of electricity, which exceeds the scope of this brief tutorial. All 

that’s required to know is that electricity is always flowing in your body, and 
it flows from parts of your body that are negatively charged to parts of your 

body that are positively charged. 

As this electricity is flowing, sensors can “tap in” to this electrical activity 

and monitor it. The volt is a unit of measure of the electrical activity at any 

instant of time. When we talk about an electrical signal (or just signal) we are 

talking about how the voltage changes over time. 

 
Electricity is part of everything 

your body does...from thinking to 
exercising—even sleeping 

The body’s electrical signals are detected with transducers and electrodes and sent via the MP data acquisition unit 

to the computer. The electrical signals can be very minute—with amplitudes sometimes in the microVolt 

(1/1,000,000 of a volt) range—the MP unit amplifies these signals, filters out unwanted electrical noise or 

interfering signals, and converts these signals into data the computer can read.  
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Waveform Concepts 

A basic understanding of what the waveforms on the screen represent will be useful as you complete the lessons. 

Amplitude is determined by the Biopac Student Lab (BSL) System based on the type of MP input. The units are 

shown in the vertical scale region; the unit for this example is Volts. 

Time is the time from the start of the recording, which is to say that when the recording begins it does so at what 

the software considers time 0. The units of time are shown in the horizontal scale region along the bottom of the 

display; the unit for this example is milliseconds (1/1,000 of a second). 
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Diving a little deeper into what a waveform represents, you are actually looking at data points that have been 

connected together by straight lines. 

These data points are established by the BSL hardware by sampling the signal inputs at consistent time intervals. 

These data points can also be referred to as points, samples, or data. 

The time interval is established by the sample rate of the BSL hardware, which is the number of data points the 

hardware will collect in a unit of time (normally seconds or minutes). The BSL software stores these amplitude 
values as a string of numbers. Since the sample rate of the data is also stored, the software can reconstruct the 

waveform. 

• Sampling the data is very similar to how a digital camera records images by taking snapshots of the image 
at specific time intervals. When the video is played back, the captured images are displayed in quick 

succession. Likewise, when you look at the waveform, you see a continuous flow rather than the data 

points and straight lines. 

The BSL Lessons software always uses the same sample rate for all channels on the screen, so the horizontal time 

scale shown applies to all channels, but each channel has its own vertical scale. A channel’s vertical scale units can 
be in Volts, milliVolts, degrees F, beats per minute, etc. A baseline is a reference point for the height or depth 

(“amplitude”) of a waveform. 

 

• Amplitude values above the baseline 

appear as a “hill” or “peak” and are 

considered positive (+). 

• Amplitude values below the baseline 

appear as a “trough” or “valley” and are 

considered negative (−) 
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Sample Data File 

This Tutorial is designed to follow along using a sample data file on a computer without BSL hardware attached. 

This means that you can complete the Tutorial on a computer outside of the classroom/lab—perhaps at the library, 

computer lab or home—just as you will always have those options for analyzing data outside the lab. Open the 

Gail-L02 sample data file as directed below. 

1. Turn the computer ON. 

2. Launch the program with 

the Desktop icon or 

Windows Start menu item 

“BIOPAC Student Lab 

4.1.” 

Mac: Applications > Biopac 

Student Lab 4.1 and click the 

program icon. 

To launch the program, use the Desktop icon   

or use the Windows® Start menu, click Programs and then select: 

 

3. In the Startup Wizard, the 

“Record or Analyze a 

BIOPAC Lesson” option 

will be selected by default. 

4. Select “Review Saved 

Data” from the “Choose a 

Lesson” menu and click 

OK. 

5. Navigate to the Sample 

Lesson Data folder. 

6. Choose the “Gail-L02” file 

and click OK. 

Once the application is open, you 

may also navigate to the Sample 
Data folder by choosing File > 

Open or from the Lessons menu. 

 

Default Windows path for Sample Lesson Data folder:  

Drive:\Program Files (x86)\BIOPAC Systems, Inc\Biopac Student Lab 

4.1\Sample Data\English-en\Sample Lesson Data 

Default Mac path for Sample Lesson Data folder: 

Applications\Biopac Student Lab 4.1\Sample Data\English-en\Sample 

Lesson Data 

NOTE: If the application has been 

previously launched in Lessons 
with hardware attached, you may 

return to the Startup Wizard by 

selecting it from the “Go to” item 

in the File menu. 
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BSL Display 

The display includes a Data window and a Journal and both are saved together in one file. 

• The Data window displays the waveforms and is where you will perform your measurements and 

analysis. 

• The Journal is where you will make notes. You can extract information from the Data window and 

paste it to the Journal. You can also export the Journal to other programs for further analysis. 

BSL software contains a variety of Display Tools, allowing you to change the data display by adjusting axis scales, 

hiding channels, zooming in, adding grids, etc. This can be very useful when you are interested in studying just a 

portion of a record, or to help identify and isolate significant data in the record for reporting and/or analysis. 

A word about keyboard shortcuts: Many BSL menu functions can be executed via keyboard shortcut 
combinations, and available shortcuts are listed to the right of the menu item. The screenshots in this tutorial are 

taken from the Windows version of BSL, where the “Ctrl” key is prominently displayed. Keyboard shortcuts 

requiring the “Ctrl” key on Windows operating systems generally are executed with the “command” key on a Mac. 

7. Review the display to 

identify the display 

elements of the Data 

Window and the Journal. 

• The Data Window 

displays waveform(s) 
during and after 

recording, and is also 

called the "Graph 

Window." Up to eight 
waveforms can be 

simultaneously 

displayed, as controlled 
by the software and 

lesson requirements. 

• The Journal works 
like a standard word 

processor to store 

recording notes and 
measurements, which 

can then be copied to 

another document, 

saved or printed. 

• Lesson Introduction, 

Lesson Procedure, 

and Analysis 

Procedure PDFs are 

available in each 

Lesson’s Help Menu. 
Following the lesson, a 

Journal summary and 

Data Report can be 
filled out onscreen, 

printed, or sent as an 

email attachment. (The 
email option must be 

enabled by the 

instructor.) 

The Gail-L02 file will open as shown below:  

 
Biopac Student Lab Display 

Top down, the sections of the display are: 

▪ Title Bar (BSL program name and file name) 

▪ Menu Bar (File, Edit, Display, Lessons) 

▪ Tool Bar (lesson specific buttons, such as Overlap and Split) 

▪ Measurement Region (channel, type, result) 

▪ Channel Box(es) and Channel Label(s) 

▪ Event marker Region (icons, text and menu) 

▪ Data window — waveform display 

▪ Horizontal scroll for Data Window 

▪ Display Tools (to the right of the Horizontal Scale) — Arrow, I-

beam, Zoom and Annotation icons 

▪ Journal Tool Bar (time, date and formatting icons) 

▪ Journal 
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Display Tools 

BSL allows complete flexibility in how the data is viewed. Chart recorders lock you into one view, but with the 

BSL you can expand or compress the visual scales to aid in data analysis. The Data window display is completely 

adjustable, which makes data viewing and analysis easier. 

• View multiple channels or hide channel(s) from the display view. 

• Zoom in on specific segments to take measurements, examine anomalies, etc. 

• View the entire record at one time to look for trends, locate anomalies, etc. 

Editing and Selection Tools 

8. Locate the editing and 

selection tool icons in the 

upper right of the Data 

Window. 

A good starting point is to understand the editing and selection tools, which 

are found in the toolbars above and to the right of the graph window. These 

are the Arrow, “I-Beam,” Zoom and Annotation tools. 

To select any of these tools simply click the mouse on the desired 

icon, and it will appear recessed to indicate it is active  

Each tool activates a different cursor in the display window: 

 Arrow cursor       I-beam cursor      

 Zoom cursor Annotation cursor 

TIP: It is recommended that you use the Zoom tool  to expand the 
default graph view for easier data viewing during this tutorial. To use the 

Zoom tool: 

• Click on the Zoom tool. 

• Position the zoom tool cursor  over a portion of data between the 

black append marker dividers (between 24 and 80 seconds). 

• Click and drag the mouse to draw a box around the area to be 

zoomed, then let go of the mouse button.  

• The zoomed area should resemble the graph below and the 

subsequent graph views in this tutorial. (See page 11 for more 

details on using the Zoom tool.) 

Active Channel 

9. Click in the CH 40 box to 
make that the “active 

channel.” 

• The channel box of the 
active channel will be 

generated to be 

recessed, and the label 
for the active channel 

will be highlighted on 

the left edge of the 

channel display. 

• You can also click on 

the channel label to 

make a channel active. 

10. Click in the CH 41 box and 

note how the label changes. 

 

 

CH 1 hidden, CH 40 active and CH 41 
shown (note “Integrated EMG” is 

highlighted on the left edge) 

 
CH 1 hidden, CH 40 shown and CH 

41 active (“Clench Force”) 

Channel boxes are in the toolbar above 

the data window. They enable you to 

identify the active channel and hide 

channels from view, so as to concentrate 
on or print out only specific waveforms at 

a time. 

The display can Show one or more data 

channels, but only one channel can be 

“active” at any time. The “active” channel 

box appears recessed. 

The Label for the active channel is 
displayed to the right of the channel boxes 

and highlighted in the display region. 
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Show/Hide a channel 

11. In this sample data file, CH 

1 is hidden by default. To 
Show or Hide a channel 

hold the “Alt” key down and 

click on the Channel box. 

a. Show CH 1. 

b. Hide CH 1. 

c. Hide CH 40. 

d. Show CH 40. 

• Showing a channel 

enables the channel 
display but does not 

make it the active 

channel. 

• Hiding an active channel 

does not prevent it from 

being the active channel. 

When you Hide a channel, the data is not lost, but simply hidden, so that 

you can focus on specific channel(s). Hidden channels can be brought 

back into view at any time. The channel box displays “slash marks” when 

it is hidden. 

      

 

Show/Hide Grid Display 

12. Simply toggle the Show 
Grid/Hide Grid buttons 

located below the Menu Bar. 

Another powerful feature is the ability to Show or Hide the grid display. A 

grid is a series of horizontal and vertical lines that assist the eye with 

finding data positions with respect to the horizontal and vertical scales.  

 

13. Select Hide Grid to turn the 

grid display OFF. 

14. Review the display without 

grids. 

Note: The Show/Hide Grid toolbar 

buttons are available during Review 

Saved Data mode only. To set the 

grid view options when recording a 
lesson, you must go to File > 

Preferences > Grids prior to 

calibration procedure. 

 

Note that the Grids display affects all channels. If you show a channel that 

was hidden when Grids were activated, the grid display will show on the 

channel. 
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15. Toggle Show Grid to turn the 

grid display ON. 

 

 

To adjust the grids, see Scales & Grids on page 13. 

Scroll - Horizontal 

16. Locate the Horizontal Scroll 

Bar at the lower edge of the 

display. 

17. Use the Horizontal Scroll to 

reposition the data with 

respect to time. 

Note that both waveforms moved. 

This is because the horizontal 

scale is the same for all channels. 

 

 

 

 

 

 

Move to different locations in the record by using the horizontal scroll bar. 

Since the horizontal scale applies to all channels in view, it will move 

every waveform simultaneously. 

The scroll bar is active when only a portion of the waveform is in view. To 
move forward or backward, select and drag the scroll box or click on the 

left or right arrow. For a continuous scroll, click on the arrow and hold 

down the left mouse button. 

 

If the entire waveform is displayed, the scroll bar will dim. 

 

 

In the sample file, the horizontal scale represents Time in seconds. The 

software will set the most appropriate Time option for each signal. 

 

 

Notice the Horizontal Scale range on the bottom changes to indicate your 

position in the record. 
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Scroll – Vertical 

18. Locate the Vertical Scroll 

Bar along the right edge of 

the display. 

 

A similar scroll bar can be found next to the vertical 

scale. This is the Vertical Scroll Bar, and it allows 
you to reposition the waveform in the active channel. 

The Vertical Scroll Bar runs along the entire right 

edge of the display window, but only applies to the 
active channel, which is only a portion of the display 

if more than one channel is displayed. 

The Vertical Scale Range for the active channel 

changes when you reposition a waveform to reflect the 

displayed range. 
 

19. Use the Vertical Scroll to 

reposition the CH 41 Clench 

Force waveform. 

• Note that the CH 40 

Integrated EMG 
waveform did not move. 

This is because the 

vertical scale is 

independent for each 

channel. 
 

      

20. Pull down the Display menu 

and select Autoscale 

horizontal to fit the entire 
waveform within the data 

window. 
 

Autoscale horizontal from the Display menu is a quick way to fit the 

entire waveform within the data window. That is, it will adjust the 

horizontal scale such that the left most portion of the screen is the start of 
the recording, and the right most portion is the end of the recording. The 

time per division setting will not necessarily be even numbers, but you can 

adjust that. 

21. Pull down the Display menu 

and select Autoscale 

Waveforms to center 
waveforms in their display 

track. 

TIP — Selecting Show All 

Data from the Display menu is a 

quick way to easily return to 
your original data display and 

view the entire record at once. 
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The Autoscale Waveforms option of the Display menu is a very handy 
tool that performs a “best fit” to each channel’s vertical scale. That is, it 

will adjust the “Scale” and “Midpoint” of each channel’s vertical scale, 

such that the waveform fills approximately two-thirds of the available 

area. 

After autoscaling, the “Scale” will probably not be set to nice even 

numbers, but you can manually adjust the scale to achieve this. 

Zoom 

22. Click on the Zoom  icon 

to select it. 

The Zoom  icon is in the upper right of the data window. The Zoom 

function is very useful for expanding a waveform in order to see more 

detail. 

23. Position the cursor in the CH 

41 Clench Force channel at 
about 10 seconds, then click 

and hold the mouse button 

down and drag the cursor to 

about 12 seconds. This will 

draw a box around the area. 

If you know the precise section of the waveform that you’d like to enlarge, 

you can use the Zoom tool to draw a box around the area. 

 

24. Release the mouse button and 

review the result. 

• Note that the Horizontal 

and Vertical Scales 

changed for the selected 

channel. 

When the mouse button is released, the boundaries of the selected area 

become the new boundaries of the data window.  
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The Vertical Scale will change for the active channel only, but the 

Horizontal Scale will change for all channels since it (time) is the same for 

all channels. 

25. Select Zoom back to “undo” 

the Zoom. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End of “Display Tools” section 

After zooming in on a section of the waveform, you may “undo” the zoom 

and revert to the scale settings (both horizontal and vertical) established 

prior to the last zoom by selecting Zoom back from the Display menu. 

The Zoom back function will “undo” multiple levels of zoom. (Ctrl+- is 

the keystroke shortcut for Zoom back.) 
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Axis & Grid Controls 

Adjust Scales 

26. Click anywhere in the 
Horizontal Axis region to 

open the settings dialog. 

• Review the Axis Range 

and Grid settings. 

27. Click anywhere in the 

Vertical Axis region to open 

the settings dialog. 

 
Note that the Vertical Axis is 

independent for each 

channel. 

• Review the Axis Range 

and Grid settings. 

Click anywhere within the Axis region (Horizontal or Vertical) and a 

settings dialog will open. Any change you make to the Horizontal or 

Vertical Axis only effects how the display and never alters the saved data 

file. You will never lose any data when you change these settings. 

The Vertical Axis is independent for each channel, so you need to select 

the appropriate channel prior to clicking on the Vertical Axis. 

 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

Start/End (Horizontal) and Upper/Lower (Vertical): Establishes the 

boundary values to fit in the display window and is useful for highlighting 

meaningful segments in the waveform. For instance: 

• If the signal has a cycle that repeats every 2 seconds, you could set the 

Horizontal Axis Range to 0-8 seconds to show 4 cycles per screen. 

• If the signal varies from -2 to +2 Volts, you could set the Vertical Axis 

to match and optimize the display. 

Precision: Establishes the number of significant digits displayed in the 

Axis region. Click and hold down the mouse on the precision number to 

generate a pop-up menu, allowing you to make another selection. 

Global Grid Settings: Opens dialog for applying master grid settings for 

all channels. 

Channel Grid Settings: Opens dialog for selectively applying grid 

settings to one or more channels. 

Grid: The Major Division is the interval for the grid line (i.e., a horizontal 

line every 2 seconds or a vertical line every 5 Kg). First Grid Line is the 
origin for the grid lines, with the Major Divisions drawn above and below 

(horiz.) or left and right (vert.) to complete the grid. Minor Divisions are 

also drawn in relation to the first grid line, if the lesson is set to show them. 

Apply to all channels is a quick way to have the scale setting apply to all 

of the vertical scales in the data window. This is particularly useful when 
all of the channels are the same type of data (i.e. 2 or 3 channels of ECG 

data). Repeated clicking in the box will toggle the option on or off. 

OK: Click on “OK” to initiate the changes made in the dialog. 

Cancel: Click on “Cancel” to if no changes are desired. 
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Measurements 

Measurements are fast, accurate, and automatically updated. The measurement tools are used to extract 

specific information from the waveform(s). Measurements are used in the Data Analysis section of every lesson, 

so understanding their basic operation is important. 

Let’s say you wanted to know the force increase between two clenches in the EMG data. You could get a rough 
estimate by eyeballing the amplitude of the peaks on the vertical scale or by measuring the peak of one and the 

peak of the next and manually calculating the difference. Or, you could take a much easier and more accurate 

reading with the “Delta” measurement of the Biopac Student Lab. You can use software shortcuts to paste 

measurement data to the Journal or copy waveform data for further analysis in other programs such as Excel. 

 

Measurement tools 

28. Review a measurement 

region to identify the 

Channel select box, the 
Measurement type box, and 

the Result box. 

 
Measurement Region 

 Channel select, Measurement type, Result 

The Channel select box includes 
options for all channels, whether 

shown or hidden, and an “SC” 

measurement option. The “SC” 

performs the measurement on the 
active channel and is a quick way to 

step through multiple channels. The 

“SC” option allows you to make 
quick measurement comparisons 

between channels using one region. 

To take a measurement from another 

channel, simply click on the desired 
channel box or click anywhere 

within the data region for the desired 

channel using the Arrow tool. 

 
Channel select options 

The measurement type box is a 

pop-up menu next to each channel 

number box that allows you to 

choose from 35 Biopac Student Lab 

measurement functions (or “none”). 

The measurement result is the 
value that the measurement 

calculates. 
 

Measurement type options 
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29. Read about Measurement 

Tools to the right. 
To use the measurement tools, you must 

a) Set the channel measurement box to the desired channel. 

b) Select a measurement type from the pop-up menu. 

c) Select an area for measurement. 

Note that you can perform these elements in any order, but all three must 

be completed to achieve a valid measurement. 

Two important points regarding measurements: 

1. The first is that the measurement only applies to data in the selected 

area of the waveform that the user specifies. 

2. Each lesson contains the same measurement options, but some may not 

be applicable to that particular lesson. This is because the measurement 
options are a standard set of tools that are always available; much like a 

scientific calculator contains a standard set of buttons, many of which 

may not be necessary for any given problem. 

The Selected Area 

30. Read about the Selected Area 

to the right. 

The “selected area” for all measurements is the area selected by the I-

Beam tool (including the endpoints). Note that the “I-beam” cursor 

position when the mouse button was first pressed defines the starting point 

and the position at release defines the end position of the selected area. 

A critical concept for the measurement tools is that the measurement 

results only apply to the area established by the “I-Beam” cursor. 

• The selected area can be a single point, an area, or the end points of a 

selected area. 

• If there is no point or area highlighted on the screen, then the 
measurement results are meaningless. 

• A result of **** means the selected area is not appropriate or 

sufficient for the measurement. 

• It is up to you to select a point or an area with the I-Beam cursor, as 

the software will never do it automatically.  

Select a single-point area 

31. Click on the I-beam  icon. 

 

32. Move the cursor over a point 

on the data. 

You will notice that whenever the cursor is over data it is displayed as  

an “I.” 

33. Click on the mouse button. 

A flashing line should appear at 

the cursor position. 

When you have a flashing line, one point of data is selected. If the line is not 

flashing, it means that you moved the cursor while the mouse button was 
pressed, and you selected more than one point of data. If this occurred simply 

click on another portion of data. 

34. Click on the Arrow tool icon 

to deactivate the point. 

When finished taking measurements, you may deactivate a point, by clicking 

on the Arrow tool icon. 
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Selecting an area (several points) 

35. Click on the I-Beam  icon. 

36. Move the cursor over a point 

on the data. 

37. Hold the left mouse button 
down and drag the mouse to 

the right. 

38. Release the mouse button. 

• An area should be 

highlighted. 
 

When the mouse button is released, an area should be highlighted (darkened) 

on the screen, as shown above. This is very similar to how you select words 

in a word processing program. 

39. Click the mouse on another 

point of data and then click on 

the Arrow tool icon to 

deactivate the point. 

When finished taking measurements, deactivate a selected area by clicking 

the mouse on another portion of data to select just one point (flashing line 

appears,) and then click on the Arrow tool icon. 

40. Set a region for CH 41 

Force and Delta.  

41. Click on the I-beam  

icon. 

42. In the Force channel, use the 
I-beam to select an area 

from the baseline to the peak 

of one clench. 

43. Review the result. 

• This example shows an 
increase of 29.00 Kg. 

Your result will vary. 

Click on the I-beam  icon to activate the I-beam cursor. 

 

If the correct region is not established by the “I-Beam” cursor for the 

measurement type, the result will be meaningless. 

Results will update automatically when you change the channel selection or 

the selected area. 
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44. You can use the Data 

Window options in the Edit 

menu to copy 
measurements to another 

program.  

Copy Measurements — Use to copy the measurement values from the data 
window to another program, such as a Word document or email for your Lab 

Report. (The values shown below are example measurements.)  

Delta(1) = 0.01392 Kg   P-P(3) = 2.48267 mV   Mean(40) = 0.15282 mV   
Value(1) = 0.06469 Kg DeltaT(40) = 4.19600 sec  

Copy Wave Data — Use to copy waveform data as a set of numbers. The 

data copied will include all wave data within the area selected by the I-beam 

cursor for all channels, whether displayed or hidden. 

sec Force EMG Integrated EMG 
4.526 0.0507694 -0.0258789 0.0121948 
4.528 0.0507694 -0.0224609 0.0123364 
4.53 0.0507694 -0.0141602 0.0124744 
4.532 0.0507694 -0.00268555 0.0124585 
4.534 0.0507694 -0.0090332 0.0124524 

Copy Graph — Use to copy the waveform data as a picture to be imported 

into other programs. The Data Window Copy functions will be applied to 
the selected area, if any. If a single point or no area is selected, the Data 

Window Copy functions will be applied to the entire data file. You may 

also use the Copy Graph button above the measurement region to perform 

the same operation.  

 

Copy Event Summary – Copies events present in graph to clipboard by 

selectable criteria. (See “Events and Markers” on page 22.) 

45. You can use the Journal 

options in the Edit menu to 

copy measurements and 

other data to the BSL 

Journal.  

See the Journal section on page 27 for details. 
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Measurement Tool Definition 

Area Area computes the total area among the waveform and the straight line that is drawn 

between the endpoints. Area is expressed in terms of amplitude units multiplied by 

horizontal units. 

BPM The beats per minute (BPM) measurement uses the start and end points of the 

selected area as a measurement for one beat, calculates the difference in time between 

the first and last selected points, and divides this value into 60 seconds/minute to 

extrapolate BPM. This would be the result obtained if you took ((1/T)*60) for a 

selected area. If more than one beat is selected, it will not calculate the average 

(mean) BPM in the selected area. 

Note: In order to get an accurate BPM value, select an area with the I-Beam cursor 

that represents one complete beat-to-beat interval. One way to do this is to select an 
area that goes from the peak of one cycle’s R wave to the peak of the next cycle’s R 

wave (R-R interval). 

Calculate Calculate can be used to perform a calculation using the other measurement results. 

For example, you can divide the mean pressure by the mean flow. 

 

The result box will read “Off” until a calculation is performed, and then it will display 

the result of the calculation. As you change the selected area, the calculation will 

update automatically. 

To perform a calculation, click on the blue exclamation point to the right of the 

measurement box to generate the “Waveform Arithmetic” dialog. 

 

Use the pull-down menus to select Sources and Operand. 

  

Measurements are listed by their position in the measurement display grid (i.e., the 

top left measurement is Row A: Col 1).  

Only active, available channels appear in the Source menu. 

You cannot perform a calculation using the result of another calculation, so calculated 

measurement channels are not available in the Source menu. 

The Operand pull-down menu includes: Addition, Subtraction, Multiplication, 

Division, Exponential. 

The Constant entry box is activated after selecting “Source: K, constant” and it 

allows you to define the constant value to be used in the calculation. 

Click OK to see the calculation result in the calculation measurement box 
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Measurement Tool Definition 

Correlate Correlate provides the Pearson product moment correlation coefficient, r, over the 

selected area and reflects the extent of a linear relationship between two data sets: ix  

- values of horizontal axis and ( )ixf  - values of a curve (vertical axis). 

You can use Correlate to determine whether two ranges of data move together. 

Association  Correlation  

Large values with large values Positive correlation 

Small values with large values Negative correlation 

Unrelated Correlation near zero 

Delta The  (delta amplitude) measurement computes the difference in amplitude between 

the last point and the first point of the selected area. It is particularly useful for taking 
ECG measurements because the baseline does not have to be at zero to obtain 

accurate, quick measurements. 

Delta S The S (delta samples) measurement is the difference in sample points between the 

end and beginning of the selected area. 

Delta T The T (delta time) measurement is the difference in time between the end and 

beginning of the selected area. 

Evt_amp Extracts the value of the measurement channel at the times where events are defined. 

The measurement result is unitless. See the Measurements section of the BSL PRO 

Manual for details.  

The amplitude is always taken from the measurement channel, which may be different 

from the channel on which events are defined. 

Evt_amp can be useful for extracting information such as the average T wave height 

within the selected interval. 

Evt_count Evaluates the number of events within the selected area. The measurement result is 

unitless. Specify Type and Location; See the Measurements section of the BSL PRO 

Manual for details. 

Evt_loc Extracts information about the times of events. The measurement result uses the units 

of the horizontal axis. Specify Type, Location, and Extract; see the Measurements 

section of the BSL PRO Manual for details. 

Expression Generates the Expression transformation dialog and offers Source “MC” 
Measurement Channel instead of “SC” Selected Channel to build recursive formulas, 

i.e. result of the expression as it was evaluated x samples ago. Data within the 

selected area is not changed. 

Freq The Frequency measurement converts the time segment between the endpoints of the 

selected area to frequency in cycles/sec. The Freq measurement computes the 

frequency in Hz between the endpoints of the selected range by computing the 

reciprocal of the T in that range.  

It will not calculate the correct frequency if the selected area contains more than one 

cycle. The start and end of the cycle must be carefully selected. 

Note: This measurement applies to all channels since it is calculated from the 

horizontal time scale. 

Integral Integral computes the integral value of the data samples between the endpoints of the 
selected area. This is essentially a running summation of the data. Integral is 

expressed in terms of (amplitude units multiplied by horizontal units). 
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Measurement Tool Definition 

This plot graphically 

represents the Integral 

calculation. 

The area of the shaded 
portion is the result.  

 
 

Kurtosis Kurtosis indicates the degree of peakedness in a distribution, e.g. the size of the 

“tails” of the distribution. Distributions that have sharp peaks in their center have 

positive kurtosis; flatter distributions have negative kurtosis; flatter distributions have 
negative kurtosis. A normal distribution has a kurtosis of 0. The following formula is 

used to extract kurtosis 
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Where from a signal (x) containing n points: 

Lin_reg Lin_reg computes the non-standard regression coefficient, which describes the unit 

change in f (x) (vertical axis values) per unit change in x (horizontal axis). Linear 

regression is a better method to calculate the slope when you have noisy, erratic data. 

For the selected area, Lin_reg computes the linear regression of the line drawn as a 

best fit for all selected data points 

Max The maximum measurement finds the maximum amplitude value within the selected 

area (including the endpoints). 

Median Median shows the median value from the selected area. 

Note The median calculation is processor-intensive and can take a long time, so you 

should only select “median” when you are actually ready to calculate. Until 

then, set the measurement to “none.” 

Mean The mean measurement computes the mean amplitude value or average of the data 

samples between the endpoints of the selected area and displays the average value. 

Min The minimum measurement finds the minimum amplitude value within the selected 

area (including the endpoints). 
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Measurement Tool Definition 

Moment Central Moment is a general-purpose statistical computation that can be used to 

compute central variance and other higher-order moments of the data within the 
selected area. Specify the order as an integer (generally). The central moment is 

computed using the following formula: 
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Where: 

x—signal; 

n—points; 

m—order. 

None Selecting none turns off the measurement channel and no result is provided. It’s 

useful when copying a measurement to the clipboard or Journal with a window size 

display of several measurements and don’t want them all copied. 

P-P The P-P (Peak-to-Peak) finds the maximum value in the selected area and subtracts 

the minimum value found in the selected area. P-P shows the difference between the 

maximum amplitude value in the selected area and the minimum amplitude value in 

the selected area. 

Rate_mean Extracts the mean value of the rate outputs within the selected area.  

Rate_median Extracts the median value of the rate outputs within the selected area. 

Rate_stddv Extracts the standard deviation value of the rate outputs within the selected area. 

Samples The Samples measurement shows the exact sample number of the selected waveform 

at the cursor position. Since the Biopac Student Lab handles the sampling rate 

automatically, this measurement is of little use for basic analysis. 

Skew Skew is a statistical measure of the degree of asymmetry in a distribution (away from 

normal Gaussian distribution,) e.g. if the distribution is weighted evenly or trends 

toward an edge. 

• A normal distribution has a skew of 0. 

• A distribution with a prominent left tail has a negative skew. 

• A distribution with a prominent right tail has a positive skew  

The following formula is used to extract skew: 
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Where a signal (x) contains n points: 
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Measurement Tool Definition 

Slope The slope measurement uses the endpoints of the selected area to determine the 

difference in magnitude divided by the time interval. The slope measurement returns 

the unstandardized regression coefficient, which describes the unit change in Y 

(vertical axis values) per unit change in X (horizontal axis). 

This value is normally expressed in unit change per second (rather than sample 

points) since high sampling rates can artificially deflate the value of the slope. When 
the horizontal axis is set to display either frequency or arbitrary units, the slope is 

expressed as a unit change in vertical axis values per change in Hertz or arbitrary 

units, respectively. When an area is selected, the slope measurement computes the 

slope of the line drawn as a best fit for all selected data points. 

Stddev Stddev (standard deviation) is a measure of the variability of data points that 

computes the standard deviation value of the data samples in the selected range. 

The advantage of the Stddev measurement is that extreme values or artifacts do not 

unduly influence the measurement.  

Sum Sum extracts a mathematical sum of the amplitudes of all of the samples within the 

selected area. This straight sum can be used as a building block for more complicated 

formulas. 

Max T Max T shows the time of the data point that represents the maximum value of the 

data samples between the endpoints of the selected area. 

Median T Median T shows the time of the data point that represents the median value of the 

selected area. 

Min T Min T shows the time of the data point that represent the minimum value of the data 

samples between the endpoints of the selected area. 

Time 

 

The Time measurement shows the exact time of the selected waveform at the cursor 

position. If a range of values is selected, then the measurement will indicate the time 

at the last position of the cursor. 

Value The value measurement displays the amplitude value for the channel at the point 

selected by the I-beam cursor. If a single point is selected, the value is for that point, 

if an area is selected, the value is the endpoint of the selected area. 

Append and Event Markers 

46. Read about Events and 

Markers to the right. 

Events and markers are used to reference important locations in the data. 

There are two basic types of markers: 

 Append markers – Appear as a diamond below the marker text box and 

are red when active. Append markers are automatically inserted when you 

begin each new recording segment and are marked with time data 

 

Event markers — Appear as inverted triangles below the marker text region 

and are red when active. Event markers can be manually entered during or 
after recording by pressing F9 and are pre-programmed for some lessons.  

 

The highlighted (colored) event marker is the active marker for which the 

selected marker text applies. 
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Add an event 

47. Use the Arrow tool to click in 

the event marker region to the 
right of the first append 

marker to add a new event. 

48. Label the new event marker 

“test marker” by entering text 

at the flashing cursor in the 

event marker text region. 

You may add event markers to your data after it has been recorded simply 

by right-clicking within the marker region using and selecting “Insert New 

Event.” This new marker will then become the current active marker, and 

you may type in the marker text box. 

 

Select an event 

You may change the active event 

marker by using the event arrow 

tools on the right edge of the 

event marker region.  

   
You may also edit, remove or paste an event summary by right-clicking on 

the event’s icon. 

 
49. Click on the right pointing 

Event tool. 

Click on the right-pointing Event tool to move to the event marker that was 

placed after the current active event (if one exists). Notice the event marker 
label and the data position. 

50. Click on the left pointing 

Event tool. 

Click on the left-pointing Event tool to move to the event marker that was 

placed prior to the current active event (if one exists). Notice the event 

marker label and the data position. 

51. Right click on any event and 

choose Edit Event. 

Right click an event and choose Edit Event to generate the Event Palette. 

From this dialog, many actions are available for editing and manipulating 
events. 

52. Click on the Find button near 

the bottom of the Event 

Palette dialog. 

53. Check the “have labels 

containing the text” box and 

Enter “maximum”. 

54. Click OK. The event marker 

containing the inputted text 

will be highlighted. 

This action allows advanced ways to Find certain markers by entering the 

marker text you want to locate. 

 
Selecting Find again will move to the next marker with the same label (if 

one exists). 

55. If no more existing event 

markers meet the search 
criteria, the dialog shown on 

the right will be displayed. 

 

56. Right click on the “Test 

Marker” and choose the Clear 

Event option to remove it. 

You cannot undo a “Clear” function, so use caution when selecting  

this option. 
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57. Right click on an event 

marker and select the Paste 

Event Summary to Journal 

option. 

These options will paste marker information to the Journal and format the 

data with an Index, Time, and Label.  

 

58. Right click on an event and 

select the Edit Event option 

to open the Event Palette. 

Note: The Event Palette contains advanced functions for editing and 

labeling events in Analysis mode.  
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Menu Options 

59. Click on the File menu and 

review the options. 

REMEMBER: keyboard 

shortcuts requiring the “Ctrl” key 

on Windows operating systems 
are executed with the “command” 

key on a Mac. 

 

Save As allows saving to your school’s 

network or other media for access to 

the file outside of the lab or for sending 

Journal reports to your instructor. 

Go To Startup Wizard allows you to 
re-launch into Lessons, PRO or Startup 

Wizard mode without exiting the 

application. 

Open from Dropbox allows you to 

access saved lesson files stored on an 
online Dropbox account from any 

computer with BSL installed. 

  
 

60. Click on the Edit menu and 

review the options and sub-

options. 

 

 
 

 

 

61. Click on the Display menu 

and review the options. 

 

TIP: Use Show All Data to view all 

the data in one screen and restore the 

data display to its original state. 

 

 

62. Click on the Lessons menu 

and review the options. 

 

NOTE: Lessons 7, 8, 9, 11, 

11A, 14, 15 & 20 are 

disabled when using MP45 

hardware (see right). 

 

MP36/35 Lessons Menu 

 

MP45 Lessons Menu 
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BSL PRO Note — 

If the Sample Data file is 

opened in the Startup Wizard 

using the “Open a graph 
file” option, the menus will 

include selected PRO 

options for advanced 

analysis. 

See your instructor or the 
BSL PRO Manual for 

functionality details. 

BSL Analysis mode 

 

BSL PRO Analysis mode 

 

• Help menu stays the 

same. 

• The full Analysis menu 

is only available in PRO 

mode. 

BSL 4.1.3 and higher: 

• BSL PRO Transform 
and FFT analysis 

menus can be added to 

standard BSL Analysis 

mode by modifying the 
Advanced Lessons 

Settings. 

To access Advanced 
Lessons Settings, select 

“Create/Record a new 

experiment” in the BSL 
Startup Wizard, go to 

“Display > Preferences 

> Lessons” and choose 

“Advanced 

Preferences.” 
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Journal 

63. Read about the Journal to 

the right. 

The Review Saved Data mode incorporates a Journal feature allowing 

you to type notes or copy measurements from previously saved data. You 

may also copy data directly to the Journal.  

64. Click anywhere in the 

Journal window to activate 

it. 

65. Click on the bar separating 
the Journal window from the 

Data window and drag to 

resize the Journal. 

 

Format Journal Entries 

66. Use the toolbar buttons at the 

top of the Journal window to 
control formatting of the 

Journal contents. Journal text 

can also be printed using the 

Printer icon. 
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67. Use the table tools to insert 

and format tables within the 

Journal window. 
 

68. The Edit > Journal menu 

options can be used to paste 
selected measurements, a 

screenshot of the graph, wave 

data or a summary of existing 

events into the Journal. 

 

If you do not want a particular measurement pasted to the Journal, go to 

the pull-down menu for that measurement and select the option “None.” 

Time and Date Stamps 

 

69. Position the cursor at the end 

of the Journal entries and 
click on the clock icon to 

activate the time stamp. 

 

Review the result. 

The Journal has stamps for the time and date, which can be useful when 

creating reports. The icons are on the left edge of the Journal toolbar. 

 

The time stamp is the “clock” icon at the top left of the Journal window. 

When you click on the clock icon, the current time (according to your 

computer’s System clock) is entered in the Journal at the cursor point. 

 10:36:20 AM 

70. Click on the calendar icon to 

activate the date stamp. 

 

Review the result. 

The date stamp is the “calendar” button to the right of the time stamp. 

When you click on the calendar icon, the current date (according to your 

computer’s System calendar) is entered in the Journal at the cursor point. 

 Monday, February 29, 2016 

Text entry 

71. Place the cursor at the point 

you wish to begin typing and 

enter text using the standard 

keyboard functions. 

To enter notes directly in the Journal, click on the Journal window and 

place the cursor at the point you wish to begin typing. 

 

Paste Measurement(s) to Journal 

72. Read about the Paste 

Measurement function. 

When using the Paste Measurement function , all the pop-up 

measurements showing a value will be written to the Journal. 

TIP Use the “None” measurement option when you don’t want a 

measurement pasted to the Journal. 

To paste a pop-up measurement into the Journal: 

1. Select the channel you want to measure by clicking it with the 

Arrow tool or use the tool to select the desired channel number from 

the channel boxes just to the left of each pop-up measurement. 

2. Choose the appropriate pop-up measurement. 

3. Use the I-beam tool to select the portion of the wave you are 

interested in. The pop-up measurement values will update instantly. 
The pop-up measurements always operate on the selected area you 

have chosen with the I-beam tool. 

• For example, choosing P-P will find the peak to peak value of 

the wave in the selected area. Choosing Max will return the 

maximum value of the wave in the selected area. 

4. Paste the measurement to the Journal using the  toolbar button or 

pull down the Edit menu and select Journal>Paste Measurement. 

Alternatively, you can use the Ctrl+M keystroke command. 
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73. Select Channel 1 in the 

Data Window. 

Select the channel you want to measure by clicking it with the Arrow 

tool or use the tool to select the desired channel number from the channel 

boxes to the left of each pop-up measurement. 

74. Set a pop-up measurement 

box for CH 1 Mean. 

75. Set a second pop-up 

measurement box for CH 

40 Mean. 

76. Use the I-beam tool to 

select the first plateau . 

 

77. Pull down the Edit menu, 
scroll to Journal and slide 

right to select Paste 

Measurements. 

78.  Review the Journal entry. 

 

 

Paste Wave Data to Journal 

79. Read about the Paste Wave 

Data function. 

The Paste Wave Data function will write all the points that make up the 

data in the selected wave area to the Journal. 

Note It’s very easy to put a lot of data into the Journal using this 
command: One second of a wave sampled at 200 Hz will paste 

200 numbers into the Journal. 

To paste wave data into the Journal: 

a. Select the desired channel by clicking it with the Arrow tool or use 

the tool to select the channel number from the channel boxes to the 

left of each pop-up measurement. This will activate the Data 

Window. 

b. Use the I-beam tool to select the desired portion of the wave. 

c. Pull down the Edit menu and scroll down to Journal then scroll right 

to Paste Wave Data. 

Wave Data can also be pasted using the Ctrl+ keystroke. 

80. Use the I-beam selection 

tool to select the portion of 

the wave you are interested 

in. 

81. Pull down the Edit menu, 

scroll down to Journal then 
scroll right to Paste Wave 

Data. 

82. Review the Journal entry. 

 

 

Paste Graph to Journal The “Paste Graph” option will paste a screenshot of the current graph 

into the Journal. 

Paste Event Summary Use the “Paste Event Summary” option to paste all or a subset of events 

to the Journal, along with the time index of when they occurred. 
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83. Export Journal Files To export Journal text and/or data to another program: 

a. Open the BSL file. 

b. Select the desired Journal text. 

c. Choose Edit > Copy to copy the Journal text. 

d. Switch to the other program. 

e. Choose Edit > Paste to paste the copied data. 

Note Before pasting data into a spreadsheet, it’s usually a good idea to 

remove any extraneous comments, so the resulting file contains 

only rows and/or columns of numbers. 

Journal Numerical Table Tools If the Journal contains a table use the Numerical Table Tools to easily 

insert measurements or numerical data into the table, which can then be 
computed and evaluated via basic mathematical operations and 

expressions. This eliminates the need to export table data to a 

spreadsheet application in order to validate statistics gathered during an 

experiment.  

 

Right-click into a table cell to insert measurement values. Use the Row 

and Column statistics to perform simple math calculations on cell 

contents and paste the result to an empty cell. 

Numerical Tools operations permitted within a Journal table: 

▪ Insert a single measurement value 

▪ Insert all measurement values 

▪ Insert all measurement values with header row 
▪ Sum, Mean and Standard Deviation statistics for table rows and 

columns 

▪ Expression evaluation 

Save Data 

84. Read about the Save 

functions to the right. 

Each student’s recording is automatically saved at the end of each 

lesson recording. It is not necessary to resave files unless the data 
is significantly altered, or a change was made to the Journal while 

in the Review Saved Data mode. 
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Once in Review Saved Data mode, you may alter the data display 

window, or enter more information into the Journal. When 

making changes to the data window, you are only changing how 

the data appears on the screen — the original data is not altered. 

Saving the changes will never delete any data. 

85. Review the save options 

under the File menu. 

• Save Changes 

• Save As (new name 

or location) 

 

Save Changes 

This option is recommended to ensure that lesson files are 

properly named and saved. (Saves the file with the existing file 

name and location.) 

Save As 

To take data home for analysis, use this option. 

Creates a copy of the original file and prompts you for a location 

to save the copy to — flash drive, network, or other media. 

86. Pull down the File menu 

and select the Save 

changes option. 

The save is automatic, no dialog or confirmation is required. 

87. Pull down the File menu 

and select the Save As 

option. 

The following dialog will be generated so you can designate a 

location for the file using the Select Folder button. 
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Printing 

88. Read about the Print 

functions to the right. 

TIP: It’s always a good idea to 

Save before printing. 

Control how data is presented on the printed page by modifying how it 

is displayed onscreen prior to selecting Print. All options related to 
printing data files apply to the waveforms as they are displayed in the 

data window. If you’ve zoomed, changed the scale, or hidden a 

channel, only the portion of data displayed onscreen will be printed. 
This is actually very useful, because oftentimes you may only want to 

display a portion of the data. 

After choosing File>Print and clicking the Print button, you will be 

prompted to select how the data will be printed. 

 

Click OK to Print Graph 

IMPORTANT! The printer 

only works with the data shown 

in the data window, which is 

often not the complete data file. 

Your actual Print dialog may vary, depending on the printer and 

operating system. This dialog should include Print Options allowing 

control over the amount of data printed on each page. 

• Print Options Print ___ plots per page 

This option determines how each page will be divided up to plot 

the data displayed in the data window. 

• For example, entering “4” will divide each page into four 

regions. 

The printed data may have an expanded time scale if the printer 

made adjustments to plot what was viewed on the screen evenly 

across the specified area. 

Fit to ___ pages 

This option determines how many pages to use to print what is 

displayed on the screen. 

• For example, entering “2” will print the data displayed in the 

window evenly across two pages. The first (left) part of the 

data displayed on screen would print on Page 1 and the second 

(right) part would print on Page 2. 

• Automatic Adjustments The software will automatically make the following adjustments prior 

to printing, which may result in slight differences between what is 

displayed and what is printed: 

• Vertical Scale — if a vertical scale in the data window is set 

to fractional numbers, then the software will slightly adjust the 

scale to use even numbers for print. 
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• Event markers — when event markers are displayed on the 
screen with associated event text, the data will print with the 

event text directly above the appropriate event and a dashed 

vertical line will run through the data to indicate the event’s 

precise point in time. If the data is compressed, events and/or 
event text may overlap or be hidden. If this is unacceptable, 

expand the time scale to allow the selected events enough 

room to print. 

89. Print the entire data file 

a. Click anywhere in the Data 
Window to make it the active 

window. 

b. Choose Display>Autoscale 

Horizontal. 

c. Choose Display>Autoscale 

Waveforms. 

d. Choose File>Print>Print 

Graph. 

e. Set Plots per page and Fit to 

pages as desired. 

f. Click OK. 

 

90. Review the printed result.  

• Print Journal The Journal is printed from its own print icon in the Journal toolbar. 

 

Journal-specific Page Setup can be accessed and modified via the  

icon. 
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Quit BSL 

91. Pull down the file menu 

and select Quit. 
During the recording mode, the application close  icon in the 

upper right corner of the display window is blocked so you can’t 
inadvertently quit the application when you simply meant to close 

the data window. 

To exit the application, choose Quit from the File menu. 

 

92. If prompted, click Yes to 

save all changes. 

93. Close the file you opened 

and close the hard drive 

window. 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 

When quitting the software after altering the data file and/or 

Journal file in any way, the following message will be generated.  
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Running a Lesson 

To run a BSL Lesson, an MP data acquisition unit must be connected. If the BSL software was installed with the 

Hardware option and an MP unit is connected, you can follow along on your computer; otherwise just read this 

section so you’ll know what to expect in the lab. 

IMPORTANT — You are free to download the Biopac Student Lab Analysis software for 
use on your personal computer. The hardware does not have to be attached for you to 

review and analyze your data files. See www.biopac.com for the BSL Analysis download. 

The primary objective of the Recording section is to assist you in obtaining good data, and the primary objective of 

the Analysis is to help you understand the data and the physiological concepts represented. Lessons are set up so 

that data can be recorded in the lab and then analyzed after class—in the lab or at home. 

FAST TRACK 

This side of the lesson (left, blue-shaded 

column) is the “FAST TRACK” through 

the lesson, which contains a basic 

explanation of each step. 

Detailed Explanation of Steps 

This side of the lesson contains more detailed 
information to clarify the steps and/or concepts in the 

FAST TRACK, and may include reference diagrams, 

illustrations, screen shots, and/or references to this 

manual. 

Although it is not absolutely necessary, BIOPAC recommends that students work in groups of at least three. 
Students should choose a Director, a Recorder, and a Subject from their lab group before beginning Set Up 

(which often involves the Subject). 

Director The Director oversees the lesson procedure and gives the Recorder and Subject specific tasks to 
perform during the lesson recordings. The Director also keeps track of the time required for each 

condition. 

Recorder  During the data recording, the Recorder will often insert event markers (press F9 on PC or Esc on 

Mac) when tasks are requested of the Subject. The recording step will indicate which event markers 

to enter. Note that event marker text can be added or edited after the recording is complete. 

Subject  This is the person from whom data will be recorded. The Subject will need to perform the tasks as 

instructed by the Director. It is suggested that the Subject not look at the computer screen while data 

is being recorded, as there tends to be a “biofeedback” effect that can bias the heart rate. 

1. Turn the computer ON. 

2. Use the desktop icon or the 
Windows Start menu item 

“Biopac Student Lab 4.1.” 

To run a lesson, the computer must have an MP unit connected. 

To launch the program, use the desktop icon  or use the 

Windows® Start menu, click Programs and then select: 

 

 

http://www.biopac.com/Updates.asp
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3. Choose the Record or 

Analyze a BIOPAC Lesson 
option in the Startup Wizard 

and select a Lesson from the 

menu. 

• The Review Saved Data 

option will generate a 

standard Open dialog so 
you can select a file for 

analysis.  

 

Note—When using MP45 hardware, a subset of the lessons shown 

above will appear in the Lessons menu. (Lessons 7, 8, 9, 11, 11A, 14, 

15 and 20 are not supported in MP45 hardware.) 

If hardware is not connected, the following prompt will appear. To run 

a lesson, check the power and connections for the MP unit and then 
click OK. 

 

4. Type in your file name. Type in your name so the BSL software can store all of your data files 

in one folder, making it easier to retrieve data later on. 

 
Enter your real name, a nickname, or the name of your study group. 
Select a unique identifier, such as the Subject’s nickname or student 

I.D. #, your full name or some combination of your name and other 

letters and/or numbers (like JohnF or John3).  

It is a good idea to use the same folder for each lesson.  
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Be sure to write down the folder you chose so that you can keep track 

of where your data is stored. 

The BSL software will allow you to use the same name ten times. If 

large numbers of students are using your computer and you try to use 

a popular name (“John” vs. “JohnF”) there is a good chance the BSL 

software will prompt you to use a different name. 

 
If you know the existing folder is your own, select Use it. This is a 
convenient way to ensure that all your lesson files for the class term 

are stored in one folder. If you Rename the folder, just add a 

character to the last name you used, i.e. “Laura” becomes “Laura2.” 
Once you enter your name and choose OK, the software creates a 

folder in the “Data Files” folder within the “Biopac Student Lab” 

folder (or in an alternate location if your instructor modified setup). 

This is where all your data will be stored. If you choose the same file 
name for other lessons, they will also be stored in this folder (with the 

appropriate lesson number extension). 

If you attempt to use the same file name an eleventh time, you will be 

prompted to choose a different name. 

 
The files inside your folder can be moved, copied, or duplicated, just 
like any other file. If you wish, you can copy them to a CD or drive as 

a backup or to be viewed later. Check with your instructor or lab 

assistant for more information on how to do this. 

When running a lesson, a prompt will be presented for entering your 

name. The BSL software creates a folder with the exact name you 
enter and places it in the Data Files folder in the Biopac Student Lab 

Program directory. When you press the Done button to end the lesson 

recording, the BSL program automatically saves your recording to the 
Data Files folder, using a file name based on the user name or I.D. 

given at the start of each lesson. 

The software will save the data file with the selected name plus an 

extension identifying the lesson number. This extension is very 

important because the software will key off this extension and open 
different tools for the Review Saved Data Mode, depending on the 

lesson. 

Other lesson data files using the same name will be placed in this 

folder, but the software does not allow saving a data file with the 

same name and lesson number.  

As a general note, because the Biopac Student Lab software is 

automatically saving the files, exercise caution when moving items 

into different folders. 
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It’s recommended that you never place other files or folders in the 

Biopac Student Lab program folder, and never take files or folders 

out of the program folder apart from removing data recording files 

from the Data Files folder. 

5. Follow the instructions in the 

lesson manual and in the 

Journal, or proceed as directed 

by your instructor. 

 

 

 

 

 

 

 

 

 

 

 

NOTE: Certain recordings may have 

been disabled by your instructor. If 

this is the case, please disregard any 
instructional references to excluded 

recordings. 

 

The recording section is very detailed and includes an HTML Journal 

with sample screen shots, tabbed instructions and even embedded 

sample videos for comparison—so, even if you don’t fully understand 

what is happening when you’re running the lesson or feel pressured 
by time (as is often the case,) you should be able to obtain good, 

meaningful data. Then, you’ll be able to analyze and grasp the 

important concepts later, during the Analysis section. 

Normally, a lesson will contain multiple recordings, with different 

tasks occurring during and/or between these segments. It is important 
that you read ahead to the next step in the lesson, so it is clear what 

task(s) you’ll need to perform during each recording segment. 

6. Step through the lesson as 
guided in the Lesson manual 

or by your instructor. 

 

To begin a Lesson, click on the Calibrate button. The dynamic 
calibration procedure will automatically optimize the BSL System for 

the signal(s) being recorded in the lesson. 

• With equipment such as an oscilloscope: If you or your instructor 
needed to modify the gain or amplification settings to make sure a 

good signal was recorded, this entire procedure had to be 

manually repeated for each new subject. Biopac Student Lab 
makes the required adjustments for you during the automatic 

calibration procedure. 

If hardware was not plugged in as directed, you will be prompted to 

correct this before continuing.  

 

 

 

 

The calibration cycle will stop automatically. 

If your calibration data does not match the sample screen shot 

provided, click Redo Calibration to erase the old data and repeat the 

calibration cycle. 
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If the calibration data matches the sample screenshot, click Continue 

to advance to the first recording. The Continue button is presented 

following Calibration, and after clicking Suspend following every 

recording. 

 
Following Continue, click Record to acquire data. 

 
Click on “Suspend” when you have completed the assigned recording 

task(s). 

When selected, the Suspend button toggles to “Record.” 

Review Recorded Data After clicking Suspend, you may wish to review the data before 

continuing. You may check your data by zooming in on a 
particular area, taking a measurement, adding grids, etc. Before 

continuing, read ahead to prepare for the next recording. 

  

 
 

 The Arrow, “I-Beam,” and Zoom tools are inactive (grayed) during 

recording but can be used between segments while in the Recording 

mode. The Display menu items are also available. 

 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 

 

To repeat the last recorded section and erase the old data, click on 

Redo. 

• The “Redo” feature is very handy and should prevent you from 

panicking during the recording. You can redo a recording if 
something goes wrong or if you realize you have not performed 

the proper tasks. 

If you are finished with the data recordings, click on Done. 
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The “Done” button in the Lesson display generates the closing options 

dialog. 

 

Record from another subject returns to the first screen of the lesson. 
Repeat the necessary set up, type in a new Subject name, and repeat 

the entire recording. Depending on the lesson, you may or may not 

have to redo the calibration.  

Analyze current data file will switch to the Review Saved Data 

mode and will automatically open the last recorded data file. 

Analyze another data file will switch to the Review Saved Data 

mode and prompt you to find and open a data file for review. 

Record another Lesson will generate the lessons menu. 

Copy to another location will generate a Save dialog, allowing you 

to designate a location to save the file. Note that you cannot change 

the file name. 

Copy to Dropbox opens a dialog for saving a file directly to an 

online Dropbox account. 

Go to Startup Wizard closes the file and returns to the initial Startup 

window. 

Quit closes all lesson windows and exits the BSL program. 

7. Save the recorded lesson data. Each student’s recording is automatically saved at the end of each 

lesson recording. It is not necessary to resave files unless you 

significantly alter the data window settings or make a change to the 

Journal while in the Review Saved Data mode. You will be prompted 
to save changes. 

 

Review Saved Data Mode 

for Data Analysis 

Data Analysis is where you analyze data to “pull out” measurements 

that reinforce the concepts presented in the Introduction. Analysis can 

be done right after the data is recorded or can be done off-line on 

another computer (the hardware does not need to be attached). The 
analysis should be done after all students have completed data 

recording. 

Measurements taken in the Analysis section are to be placed in the 

Data Report section of the Lesson Procedure and may also be placed 

in the on-screen Journal for saving and printing. Whenever a 
measurement needs to be placed in the Data Report, a reference icon 

will direct you to the proper section of the Data Report. 
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Lesson Specific Buttons 

Some lessons have extra buttons (under the menu bar) for features appropriate to the lesson signal and/or protocol. 

The following buttons are not in the sample file, so just read about them below. 

 
The Stop button is presented in Lessons 1 and 2 only, following the end 

of data recording before the optional Listen segment. 

 
The Listen button enables monitoring of the EMG signal as audio 

output when headphones are connected. 

  
The Overlap and Split buttons allow you to merge or separate the data 

channels (“tracks”) in the display window. 

 
Overlap mode 

 
Split mode 

   
The Show Grid and Hide Grid buttons will toggle grids on and off. 

(Available in Analysis mode) 

 
Copy Graph allows you to copy the waveform data as a picture to be 

imported or pasted into other programs. (Available in Analysis mode) 

 

             

The Adjust Baseline button is only used in “Lesson 5 ECG I” and 

allows the waveform to be moved up or down in small increments to 
establish an exact-zero baseline. This is not necessary to obtain accurate 

amplitude measurements but may be desired before making a printout or 

when using grids. 

When you click the Adjust Baseline button, Up and Down buttons will 

appear. Simply click on these to move the waveform to the desired 
position. The Exit button will close the Adjust Baseline options and 

return to the waveform display. 

 
The Minus/Plus buttons will adjust the size of the graph window. 

   

 

These buttons allow toggling between Fixed Interval or Random 

Interval presentation when additional Lesson 11 or 11A segments are 
recorded. Lesson 11A also includes a Change Intensity toolbar button 

for varying the brightness/dimness of the visual stimulus LED. (In 

Optional Active Learning portion only.) 
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Legalese 

Copyright 

Information in this document is subject to change without notice and does not represent a commitment on the part 

of BIOPAC Systems, Inc. This tutorial and the software it describes are copyrighted with all rights reserved. Under 
copyright laws, this tutorial or the software may not be copied, in whole or part, without the written consent of 

BIOPAC Systems, Inc., except in the normal use of the software or to make a backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. 

This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased 

(with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes 

translating into another language or format. 

Biopac Student Lab Tutorial, including all text and graphics, are ©1998-2019 BIOPAC Systems, Inc., with all 

rights reserved. 

 

Limited Warranty 

BIOPAC Systems, Inc. guarantees its equipment against all defects in materials and workmanship to the original 
purchaser for a period of 12 months from the date of shipment unless otherwise stated below; effective 1-1-2015, 

BIOPAC MP36 units are guaranteed against defects in materials and workmanship to the original purchaser for a 

period of 60 months (5 years) from the date of shipment. 

If BIOPAC Systems, Inc. receives notice of such defects during the warranty period, BIOPAC Systems, Inc. will 

at its option, either repair or replace the hardware products that prove to be defective in materials or workmanship. 
This warranty applies only if your BIOPAC Systems, Inc. product fails to function properly under normal use and 

within the manufacturer’s specifications. This warranty does not apply if, in the sole opinion of BIOPAC Systems, 

Inc., your BIOPAC Systems, Inc. product has been damaged by alteration, accident, abuse, misuse, neglect, 

improper packing, shipping, modification or servicing, by any party other than BIOPAC Systems, Inc. If a problem 

arises, please contact us for authorization before returning an item. 

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC Systems, Inc. 

BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment containing any shipping 

carton which does not have the RMA number(s) displayed on the outside. The Buyer will prepay transportation 

charges to the BIOPAC Systems, Inc. designated site. The warranty period for repairs and for used equipment 

purchased from BIOPAC is 90 days. 

BIOPAC Systems, Inc. makes no other warranty or representation, either expressed or implied, with respect to any 

hardware or software product, its quality, performance, merchantability, or fitness for a particular purpose.  

BIOPAC Systems, Inc. will not be liable for direct, indirect, special, incidental, or consequential damages resulting 

from any defect in a hardware or software product or its documentation, even if advised of the possibility of such 

damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. product. 

 

Trademarks 

BIOPAC is a registered trademark of BIOPAC Systems, Inc. 

Apple and Macintosh are trademarks of Apple Computer, Inc. 

Windows is a trademark of Microsoft Corporation. 

This document was created with Microsoft Word for Windows, Adobe Photoshop, Corel Draw 7.0. Mainstay 

Capture, JASC, Inc. JasCapture and FastStone Capture. 

 


